Annual Dinner

This year's WSS Annual Dinner is at the MeiWah restaurant in Chevy Chase, Maryland (Friendship Heights Metro), Wednesday, June 25, 2008. The Gertrude Cox Award winner is Dr. Thomas Lumley from the University of Washington. Dr Lumley will speak at the dinner. The title of the talk is to be announced. The price for the dinner is $45 person.

2008 Wray Jackson Smith Scholarship

Applications due by April 15, 2008! The Government Statistics Section (GSS) and Social Statistics Section (SSS) of ASA are pleased to announce the availability of a scholarship in memory of Wray Jackson Smith, a founding member of the GSS and long-time contributor to Federal statistics. The Wray Jackson Smith Scholarship (WJSS), co-sponsored with the Washington Statistical Society, the Caucus for Women in Statistics, Harris-Smith Institutes, Mathematica Policy Research, and Synectics for Management Decisions, Inc., is intended to reward promising young statisticians for their diligence, thereby encouraging them to consider a future in government statistics. Everyone is encouraged to seek out promising candidates and to urge them to apply.

Type of Project

The WJSS Award provides funding of $1,000 for use in exploring any of a broad number of opportunities for furthering the development of a career related to government statistics. Applicants are encouraged to be creative in seeking support for a wide variety of uses, including:

* Tuition, board, and books for courses or short courses
* Conference attendance
* Purchase of books, software, data sets, or other supporting materials for research projects related to government statistics.

Activities may relate to any level of government, including Federal, state, and local governmental units. They must be statistical in nature, focusing on data, methodology, analysis, or data presentation. Recent award winners have used the WJSS to fund attendance at the Joint Statistical
Meetings, support continued public policy research, and to take short courses to better understand and analyze data for current research.

**Application**

To apply for a WJSS Award, the following information must be sent to the Wray Jackson Smith Scholarship Committee by April 15, 2008:

- A completed WJSS Application Form (see:<http://www.amstat.org/sections/sgovt/> for current year’s form and click on the format you want to use)
- A proposal of activity to be funded
- Academic transcript (for current/recent students) or job performance reviews for the past 2 years (for non-students) or equivalent proof of superior academic and/or professional performance
- Two letters of recommendation.

Please send materials to:

*Wray Jackson Smith Scholarship Committee*

c/o Michael P. Cohen

1615 Q Street NW #T-1

Washington DC 20009-6310 USA

or electronically to: mpcohen@juno.com

**Selection Process**

The WJSS Committee, consisting of a total of three GSS and SSS members, will review each proposal, based on an established rating scheme, and select the awardee. Each application will be judged based on the following criteria:

- Stage in Career
- Past Performance
- Quality of the Proposed Activity
- Relevance of Activity to Government Statistics
- Innovation/Ingenuity of the Proposed Project
- Feasibility of Completion of Activity
- Two Letters of Recommendation
Announcements of the awardees are made by June 1, 2008. All applicants are notified by e-mail.

**Eligibility**

The WJSS is targeted at students and persons early in their career in government statistics. Applicants must have a Bachelor’s degree or equivalent level of education. Membership in the Government Statistics Section, Social Statistics Section, or in the ASA is not required. For more information, contact Mike Cohen by e-mail: mpc@juno.com

**Wray Jackson Smith Scholarship Committee**

The Committee for 2008 consists of Michael P. Cohen (Chair) mpc@juno.com, Robert A. Kominski Robert.A.Kominski@census.gov, and Stephen Campbell Stephen.Campbell@nist.gov. The Committee members thank Juanita Tamayo Lott for her invaluable advice and assistance.
WSS and Other Seminars
(All events are open to any interested persons)

April
2 Wed. Studies in Military Medicine from the Center for Data Analysis and Statistics (CDAS) at West Point

8 Tues. Using the Peters-Belson Method in EEO Personnel Evaluations

8 Tues. Two-sample rank tests for treatment effectiveness when death and censoring depend on covariates

15 Tues. Assessing Disclosure Risk, and Preventing Disclosure, in Microdata

May
5 Mon. Statistical Issues Arising in the Interpretation of a Measure of Relative Disparity Used in Educational Funding: The Zuni School District 89 Case

13 Tues. Multivariate Event Detection and Characterization

15 Thur. President's Invited Seminar: What's Up at the ASA?

Also available on the Web at the following URL: http://www.scs.gmu.edu/~wss/
Announcement

SIGSTAT Topics for Spring 2008

April 16, 2008: Survival Models in SAS: PROC PHREG  Part 1
(http://www.sas.com/apps/pubscat/bookdetails.jsp?pc=55233)

Continuing the series of talks based on the book "Survival Analysis Using the SAS System: A Practical Guide" by Paul Allison begun in October 2007, we’ll start Chapter 5: Estimating Cox Regression Models with PROC PHREG.

Topics covered are:
   1. The proportional hazards model
   2. Partial likelihood
   3. Tied data

May 21, 2008: Survival Models in SAS: PROC PHREG – Part 2

Continuing the series of talks based on the book “Survival Analysis Using the SAS System: A Practical Guide” by Paul Allison begun in October 2007, we’ll continue with Chapter 5: Estimating Cox Regression Models with PROC PHREG.

Topics covered are: Tied data

June 18, 2008: Survival Models in SAS: PROC PHREG – Part 3

Continuing the series of talks based on the book “Survival Analysis Using the SAS System: A Practical Guide” by Paul Allison begun in October 2007, we’ll continue with Chapter 5: Estimating Cox Regression Models with PROC PHREG.

Topics covered are: Time-Dependent Covariates

SIGSTAT is the Special Interest Group in Statistics for the CPCUG, the Capital PC User Group, and WINFORMS, the Washington Institute for Operations Research Service and Management Science.

All meetings are in Room S3031, 1800 M St, NW from 12:00 to 1:00. Enter the South Tower & take the elevator to the 3rd floor to check in at the guard’s desk. First-time attendees should contact Charlie Hallahan, 202-694-5051, hallahan@ers.usda.gov, and leave their name. Directions to the building & many links of statistical interest can be found at the SIGSTAT website, http://www.cpcug.org/user/sigstat/.
Announcement

Girl Scout Science Day
Udvar-Hazy Center
National Air and Space Museum
Smithsonian Institutions

The Girl Scout Council of the Nations Capital sponsored a Girl Scout Science Day on March 8 at the Steven F. Udvar-Hazy Center of the National Air and Space Museum. Over 40 groups representing professional societies, government agencies, science clubs, etc - brought in hands-on educational exhibits designed to introduce principles of general aviation, science, statistics, environmental science, etc., to Girl Scouts ranging in age from Daisys (kindergarten) to Seniors (high school). In addition to the more than 2000 Girl Scouts and family members registered for the event, the Center was also open to the public. The Washington Statistical Society (WSS) booth, staffed by Todd Blessinger, Stephine Keeton, Jurate Landwehr, Carl Landwehr, and Anna Nevius, introduced probabilistic concepts of a “fair” versus “unfair” game. Scouts were invited to roll one of two types of large foam dice. The "fair" dice had all smooth sides whereas the “loaded” dice had one corner cut out. After rolling a die, the Scouts were invited to register their result on a poster board with a sticker in a column above the appropriate die face number, creating an evolving bar chart. (Results were also compiled on a computer program.) Much to the chagrin of the WSS members, at the end of the day with a total number of 276 and 278 rolls recorded for the fair and loaded dice, respectively, both distributions looked about comparable! Various conjectures why this might be included: the dice were not manufactured with exact precision so the fair dice were not really fair; scouts were dropping the dice rather than rolling them so the experiments was not consistently conducted, or the sample size was not large enough. In any case, the WSS group enjoyed interacting with the girls and their leaders and parents. The group also passed out flyers to interested parents and leaders about the ASA poster contest for K-12 and the WSS special project contest for middle school and high school students. In addition, the Girl Scouts provided a lovely free box lunch and cookies to all volunteers. Plus, the Center is a just great place to spend the day. The Girl Scout Council will probably sponsor another Girl Scout Science Day in two years. If you are interested, contact Carolyn Carroll, WSS QL (Quantitative Literacy) Coordinator.
Announcement

A TWO-DAY WORKSHOP ON
BAYESIAN METHODS THAT FREQUENTISTS SHOULD KNOW
THE UNIVERSITY OF MARYLAND STATISTICS CONSORTIUM
COLLEGE PARK, APRIL 30 -MAY 1, 2008

Co-sponsors:
The University of Maryland Statistics Consortium
Office of Research and Methodology, National Center for Health Statistics, CDC Survey Research
Methods Section of the American Statistical Association Washington Statistical Society

The main purpose of the workshop is to assess the current state of usage of the Bayesian
methodology in different disciplines and to discuss potential issues preventing the applications of
the Bayesian methods. The workshop will highlight methods that have broad interest and appeal
cutting across the Bayesian/Frequentist divide.

The two-day Program will consist of six plenary sessions, a pair of general lectures (the Statistics
Consortium Distinguished Lectures) in a special afternoon session on Wednesday, April 30, and a
Poster Session to be held during a general Reception immediately following the general lecture
session. The plenary sessions each consist of a 45 minute to 1 hour lecture with a formal discussion
wherever possible, followed by floor discussion.

The confirmed participants of the plenary sessions and general lectures are: James O. Berger (Duke
University), Snigdhansu Chatterjee (University of Minnesota), Malay Ghosh (University of Florida,
Gainesville), Stephen Fienberg (Carnegie Mellon University), Roderick J.A. Little (University of
Michigan, Ann Arbor), Carl N. Morris (Harvard University), J.N.K. Rao (Carleton University) and
Alan M. Zaslavsky (Harvard University).

Posters that are related to the theme of the workshop will be accepted, subject to space constraints.
Please visit the workshop web site http://www.jpsm.umd.edu/stat/workshop for detailed information
on the workshop, on the Statistics Consortium Distinguished Lectures, and on submission of
abstracts for posters. There is no registration fee for attending the workshop, the Statistics
Consortium Distinguished Lectures or the reception. We strongly request that you indicate your
interest by completing the registration form, which can be downloaded from the website, and
sending it to statcons@math.umd.edu or to: Eric Slud, Statistics Consortium, Mathematics
Department, Mathematics Building, University of Maryland, College Park, MD 20742, USA, by
March 15, 2008. Note that there is no registration fee for attending the workshop.
Program Announcement

Title: **Studies in Military Medicine from the Center for Data Analysis and Statistics (CDAS) at West Point**

Speakers:
- LTC Rodney X. Sturdivant, Ph.D., Center for Data Analysis and Statistics (CDAS), Department of Mathematical Sciences, United States Military Academy, West Point, NY
- MAJ Krista Watts, M.S., Center for Data Analysis and Statistics (CDAS), Department of Mathematical Sciences, United States Military Academy, West Point, NY

Chair: Myron Katzoff, CDC/National Center for Health Statistics

Date/Time: April 2, 2008 (Wednesday) / 12:30 - 2:00 p.m.

Location: Bureau of Labor Statistics Conference Center. To be placed on the seminar attendance list at the Bureau of labor Statistics, email your name, affiliation and seminar name to wss_seminar@bls.gov (note that there is an underscore after wss') by noon at least two days in advance of the seminar or call 202-691-7524 and leave a message with this information. Bring a photo ID to the seminar. BLS is located at 2 Massachusetts Ave., NE. Take the Red Line to Union Station.

Sponsors: WSS Public Health and Biostatistics & Defense and National Security Sections

Abstract: The importance of maintaining and improving the health and fitness of soldiers in the Army has always been high. Stresses of combat as an Army at war have made concerns in this area even greater and highlighted new areas where improvements are necessary. The military medical community has responded with new treatment ideas that have resulted in studies that will both contribute to efforts on behalf of our soldiers and impact medical practices more generally. The Center for Data Analysis and Statistics (CDAS) has been involved in several of these studies in support of Walter Reed, Beaumont Army Medical Center and Keller Army Community Hospital. We will discuss several of these studies and the results to include Leishmania detection, ACL repair, air casts, LASEK surgery, incidence rates for injuries among different demographics, lumbar support for air crews and medical leadership.
Program Announcement

Title: Using the Peters-Belson Method in EEO Personnel Evaluations

Speaker: Michael Sinclair, Director of Statistical Analyses, Equal Employment Advisory Council

Chair: Hormuzd A. Katki, National Cancer Institute

Statistical discussant: Barry Graubard, National Cancer Institute

Legal discussant: Jeffrey Bannon, EEOC

Date/Time: Tuesday, April 8, 2008 / 12:30 to 2:00 p.m.

Location: Bureau of Labor Statistics Conference Center. To be placed on the seminar attendance list at the Bureau of Labor Statistics, you need to email your name, affiliation and seminar name to wss_seminar@bls.gov (note that there is an underscore after "wss") by noon at least two days in advance of the seminar. Bring a photo ID to the seminar. BLS is located at 2 Massachusetts Ave., NE. Take the Red Line to Union Station.

Sponsor: Human Rights Committee

Abstract: The Peters-Belson method was developed to examine wage discrimination using linear regression analyses. In application, one conducts a regression analysis on the favored class and applies it to the non-favored class to identify a disparity between the actual and predicted values. Recently, the method was extended to examine health care disparities and other forms of discrimination for binary outcomes via logistic regression. In this paper, we will examine the general properties in personnel hiring discrimination evaluations as compared to a standard regression analysis as related to the size of the applicant pool, the differences in the traits for the favored and non-favored class members and the employer's uniform consideration applied for factors by class. We will also discuss some of the philosophical and legal issues from selected court cases surrounding the use of this approach relative to a standard regression analysis and the methodology for applying a jackknife variance estimator to measure the statistical precision in the disparities.
Program Announcement

Title: Two-sample rank tests for treatment effectiveness when death and censoring depend on covariates

Date/Time: Tuesday, April 8, 2008 / 11:00 a.m. to 12:00 p.m.

Place: Conference room 9201, 6701 Rockledge Drive, Bethesda, MD 20892

Sponsor: Office of Biostatistics Research, National Heart, Lung and Blood Institute, National Institutes of Health

Abstract: Popular two-sample rank tests for treatment effectiveness in clinical trials rely on the independence of death and censoring, yet there are often baseline covariates on which survival and potentially also censoring may depend. Suppose that survival $T$ and censoring $C$ are conditionally independent given covariates $V$, and that treatment-allocation $Z$ is independent of $V$. In a paper of Slud and Kong (Biometrika 1997), an assumption was introduced [essentially, that the conditional survival function for censoring is the sum of a function of $(Z,t)$ and another function of $(V,t)$] under which the usual logrank test was shown to be consistent. But this assumption is not fully general, and DiRienzo and Lagakos (2001, papers in Biometrika and JRSSB) proposed a bias-correcting weighting for the logrank and studied its performance. In this talk, some theoretical results are presented on asymptotic validity of tests based on an estimated form of their weighting function. Simulations will show the good performance of these methods, and theoretical calculations show that these weight-adjustments cannot simply be ignored.

For current and future OBR seminar series, please contact: Gang Zheng (zhengg@nhlbi.nih.gov) or Jungnam Joo (jooj@nhlbi.nih.gov)
Program Announcement

Title: Assessing Disclosure Risk, and Preventing Disclosure, in Microdata

Chair: John Czajka, Mathematica

Speakers: J. Neil Russell, National Center for Education Statistics
Michael Weber, Internal Revenue Service; and Sonya Vartivarian, Mathematica
Sam Hawala, U.S. Census Bureau

Date/Time: Tuesday, April 15, 2008 / 12:30 to 2:00 p.m.

Location: Bureau of Labor Statistics, Conference Center. To be placed on the seminar attendance list at the Bureau of Labor Statistics you need to e-mail your name, affiliation, and seminar name to wss_seminar@bls.gov (underscore after 'wss') by noon at least two days in advance of the seminar or call 202-691-7524 and leave a message. Bring a photo ID to the seminar. BLS is located at 2 Massachusetts Avenue, NE. Use the Red Line to Union Station.

Sponsor: Methodology Program, WSS

Abstract (Russell): Matching NCES Data to External Databases to Assess Disclosure Risk

The National Center for Education Statistics (NCES) is the Federal statistical agency responsible for collecting information on the condition of education in the United States. The agency's Disclosure Review Board (DRB) reviews and approves all microdata products prior to release. Since the early 1990s, the DRB has required that survey programs that release public-use microdata files (PUMFs) match to external databases as part of a disclosure risk analysis. Most NCES PUMFs have been matched to external databases to model an intruder's behavior for trying to disclose a respondent's identity. This presentation will focus on two features of this process. First, we will chronicle the history of matching at NCES as a disclosure risk assessment method. Second, we will present general findings of the disclosure risks discovered by matching to external databases.


The Statistics of Income Division (SOI) currently measures disclosure risk through a distance based technique that compares the Public Use File against the population of all tax returns and uses top-coding, subsampling and multivariate microaggregation as disclosure avoidance techniques. SOI is interested in exploring the use of other techniques that prevent disclosure while providing less
data distortion. Synthetic or simulated data may be such a technique. But while synthetic data may be the ultimate in disclosure protection, creating a synthetic dataset that preserves the key characteristics of the source data presents a significant challenge. An additional constraint in creating synthetic data for the SOI PUF is found in maintaining the accounting relationships among numerous income, deduction, and tax items that appear on a tax return.

Abstract (Hawala): **Data Synthesis via Expert Knowledge, Modeling, and Hot Deck**

The presentation will focus on a method to produce synthetic data through the combined use of expert knowledge, model fitting to the data, and matching using the model predicted values. All three elements play an important role in the successful reproduction of the aggregate behavior and the main features of a data set.
Program Announcement

Title: Statistical Issues Arising in the Interpretation of a Measure of Relative Disparity Used in Educational Funding: The Zuni School District 89 Case

Speaker: Joseph L. Gastwirth, Department of Statistics, George Washington University

Discussant: Marc Rosenblum, Office of the General Counsel and Chief Economist, Equal Employment Opportunity Commission

Chair: Michael L. Cohen, Committee on National Statistics

Date/Time: Monday, May 5, 2008 / 12:30 to 2:00 p.m.

Location: Bureau of Labor Statistics Conference Center. To be placed on the seminar attendance list at the Bureau of labor Statistics, you need to email your name, affiliation and seminar name to wss_seminar@bls.gov (note that there is an underscore after 'wss') by noon at least two days in advance of the seminar or call 202-691-7524 and leave a message with this information. Bring a photo ID to the seminar. BLS is located at 2 Massachusetts Ave., NE. Take the Red Line to Union Station.

Sponsor: WSS Section on Public Policy

Abstract: This seminar will discuss statistical issues that arose in recent cases. The first case concerns the interpretation of a formula Congress wrote when it revised a law that provides funds for educating children in areas with a large federal presence (e.g. major research lab). Because federal land is not subject to local real estate tax, the primary source of funding education, the law is intended to assist the relevant school districts. We will discuss the statute and the various interpretations that arose during the proceedings and the justifications provided. A counter-example to one of the assertions made by the lawyers at the Supreme Court hearing, which appears to have been accepted by the Court's majority, will also be presented.
Program Announcement

Title: Multivariate Event Detection and Characterization

Speaker: Daniel B. Neill, Carnegie-Mellon University

Chair: Myron Katzoff, CDC/National Center for Health Statistics

Date/Time: Tuesday, May 13, 2008 / 12:30 to 2:00 p.m.

Location: Bureau of Labor Statistics Conference Center. To be placed on the seminar attendance list at the Bureau of Labor Statistics, you need to email your name, affiliation and seminar name to wss_seminar@bls.gov (note that there is an underscore after ‘wss’) by noon at least two days in advance of the seminar or call 202-691-7524 and leave a message with this information. Bring a photo ID to the seminar. BLS is located at 2 Massachusetts Ave., NE. Take the Red Line to Union Station.

Sponsor: Defense and National Security Section

Abstract: We present the multivariate Bayesian scan statistic (MBSS), a general framework for event detection and characterization in multivariate spatial time series data. MBSS integrates prior information and observations from multiple data streams in a principled Bayesian framework, computing the posterior probability of each type of event in each space-time region. MBSS learns a multivariate Gamma-Poisson model from historical data, and models the effects of each event type on each stream using expert knowledge or labeled training examples. We evaluated MBSS on various disease surveillance tasks, detecting and characterizing disease outbreaks injected into three streams of Pennsylvania medication sales data. We demonstrated that MBSS can be used both as a "general" event detector, with high detection power across a variety of event types, and a "specific" detector that incorporates prior knowledge of an event's effects to achieve much higher detection power. MBSS has many other advantages over previous event detection approaches, including efficient computation and easy interpretation and visualization of results, and allows faster and more accurate detection by integrating information from the multiple streams. Most importantly, MBSS can model and differentiate between multiple event types, thus distinguishing between events requiring urgent responses and other, less relevant patterns in the data. This talk will present an overview of the MBSS framework, and compare MBSS to other recently proposed multivariate detection approaches. Time permitting, I will also discuss how incremental learning (both passive and active) can be incorporated into the MBSS framework and used to improve detection performance, and consider extensions of MBSS to more general pattern detection problems.
Program Announcement

Title: President's Invited Seminar: What's Up at the ASA?

Chair: Michael P. Cohen, WSS President

Speaker: Ron Wasserstein, ASA Executive Director

Date/Time: Thursday, May 15, 2008/12:30 pm to 2:30 pm

Location: Bureau of Labor Statistics, Conference Center. To be placed on the seminar list attendance list at the Bureau of Labor Statistics you need to e-mail your name, affiliation, and seminar name to wss_seminar@bls.gov (underscore after ‘wss’) by noon at least 2 days in advance of the seminar or call 202-691-7524 and leave a message. Bring a photo ID to the seminar. BLS is located at 2 Massachusetts Avenue, NE. Use the Red Line to Union Station.

Sponsor: WSS

Abstract: ASA Executive Director Ron Wasserstein will provide a brief update on activities and directions of the association. However, most of the session will be devoted to questions and comments from the participants. Among the many things we could discuss:

· What needs to be done to attract and retain statisticians in government service, and what role could the ASA play?

· What benefits and services could the ASA provide that would increase its attractiveness to public and private sector members in this area?

· Where do you see the profession heading in the next few years, and what should the ASA be doing?

Ron has his opinions, of course, but is most interested in hearing yours.
JPSM HOME PAGE: http://www.jpsm.org Click on "Short Courses"

INFORMATION, REGISTRATION, PAYMENT AND CANCELLATION:
https://projects.isr.umich.edu/jpsm/

SPONSOR AFFILIATES: https://projects.isr.umich.edu/jpsm/sponsorlist.cfm

April 17-18, 2008 (Open for registration)
Cognitive Interviewing: A Hands-on Approach
Gordon B. Willis
Registration Deadline: April 3, 2008
Information: https://projects.isr.umich.edu/jpsm/materials/2008-0417.html

May 5-6, 2008 (Open for registration)
Sampling and Estimation for Establishment Surveys
Richard L. Valliant and Phill Kott
Registration Deadline: April 25, 2008
Information: https://projects.isr.umich.edu/jpsm/materials/2008-0506.html

May 20-21, 2008 (Open for registration)
Applied Structural Equation Modeling
Patrick Sturgis
Registration Deadline: May 6, 2008
Information: https://projects.isr.umich.edu/jpsm/materials/2008-0520.html

May 27-28, 2008 (Not yet open for registration) Focus Groups from Start to Finish David Morgan

Primary Funding for JPSM is from the Interagency Council on Statistical Policy
Students’ Corner

Jill Montaquila, the former president of the Washington Statistical Society, recently pointed me to a website that lists job opportunities for statisticians. If you’re looking for a job, consider trying out this website: [http://jobboard.casro.org](http://jobboard.casro.org) Thanks, Jill!

A friend of mine, Doug Galbi, suggested that I check out a website named “Many Eyes”. This website encourages users to upload data for other users to visualize. (To me, “visualize” suggests exploratory analyses.) I thought that this might be interesting to a student of statistics, especially since there may be interesting data sets available through the website.

[http://services.alphaworks.ibm.com/manyeyes/home](http://services.alphaworks.ibm.com/manyeyes/home) Thanks, Doug!

A recent issue of Wired magazine had an article about a real-world application of pattern classification.

[http://www.wired.com/techbiz/media/magazine/16-03/mf_netflix](http://www.wired.com/techbiz/media/magazine/16-03/mf_netflix) It is about the NetFlix Prize; see [http://www.netflixprize.com/](http://www.netflixprize.com/). This was of particular interest to me because I am currently taking a class in Pattern Recognition. Perhaps you can try your hand at this competition and win a million dollars. You could then use the money to pay your tuition!

A classmate of mine recently mentioned that she is learning to program in C++. This delighted me, since I sometimes use C++ in my work, and I have wondered whether C++ programming would be useful to statisticians in general. After all, one could always program in SAS, MATLAB, or R. But my classmate reports that many job advertisements she has seen do in fact mention C++ programming skills as desirable, if not required.

So, I thought I’d present a tutorial on getting started with scientific programming in C++. The original tutorial that I drafted on this topic was too long, so I decided to split it into two. This month I’ll present the first half, in which we’ll first install Dev-C++, a full-featured C++ integrated development environment. Next, we’ll compile a small “Hello World” program to demonstrate the basics of compiling a program in Dev-C++. Finally, we’ll download the source code for Newmat, a C++ implementation of useful linear algebra classes and functions, and then use Dev-C++ to compile it into a statically linked library.

In my earlier tutorial on LaTeX, the intent was not to have you become a LaTeX expert in one day, but simply to introduce you to two free tools to get started, MiKTeX and TeXnicCenter. Similarly, my intent here is not to turn you into a C++ expert in one day (and I myself do not claim to be a C++ expert), but simply to showcase two free tools to get started. As with the earlier LaTeX tutorial, I have chosen to do this tutorial under a Windows environment rather than, say, a Linux environment, simply because I suspect that most of us students still have ready access to Windows machines rather than other sorts of computers. And as with the earlier tutorial, you’ll need administrator privileges to install Dev-C++ on a computer. If you don’t have such privileges, you’ll need to ask your system administrator to do the installation for you.

By necessity, I’ll assume that you have some basic familiarity with Windows, such as how to navigate through folders, how to click-and-drag an icon, and how to copy and duplicate files. I’ll use the convention that, e.g., <Control-F9> means to press the Control key, and while keeping it depressed, press the F9 key; then let go of both keys. Another convention I’ll use is that if I say to select something like File → New → Project... within Dev-C++, it means to go to Dev-C++’s main menu, select File, which makes further options available; from these further options select New, which makes further suboptions available; and from these suboptions select Project. Also, I will use the words folder and directory interchangeably.

1. **Install Dev-C++ (Programming Environment)**

I’ll assume here that you don’t have an older copy of Dev-C++ or the GCC compiler already installed on your computer. Go to this webpage: [http://www.bloodshed.net/dev/devcpp.html](http://www.bloodshed.net/dev/devcpp.html) Towards the bottom of the page, under Downloads, you’ll see three entries with “SourceForge” hyperlinks. Click on the “SourceForge” hyperlink under the entry labeled “with Mingw/GCC”, since we’ll need the GCC compiler. This will cause you to download the Dev-C++ installation file, perhaps to your desktop; it will have a name like devcpp-4.9.9.2_setup.exe (the exact name may vary depending on the current version). After the file is downloaded to your computer, double-click on the file and follow the installation wizard’s instructions. Again, you’ll need to have administrator privileges to perform this software installation. I’d recommend you install Dev-C++ into the default directory, C:\Dev-Cpp.
2. Create Folders

To prepare for the rest of this tutorial, go into some folder where you have write privileges, such as your home folder – e.g., C:\Documents and Settings\XXX, where XXX is your login name – and create a folder there named C++. Then go into the newly created C++ folder, and in it create three folders named helloworld, newmat, and matrixdemo.

Create New C++ Project: Hello World!

OK, we’re ready to try programming in Dev-C++. As Kernighan and Ritchie wrote many years ago, the first program in any language is the same – it’s a program to write a simple message to the computer screen (Kernighan and Ritchie, 1978).

Invoke Dev-C++ by clicking on the start button in the lower left corner of the Windows desktop, and then selecting All Programs Æ Bloodshed Dev-C++ Æ Dev-C++. (You might also be able to invoke Dev-C++ through your Quick Launch bar or your Start Menu, or by browsing to the Dev-C++ installation folder C:\Dev-Cpp and double-clicking on the file named devcpp.exe found therein.) You will be greeted by a "Tip of the Day" window; read the tip, then dismiss the window by clicking on the Close button. The Dev-C++ window will look something like this:

![Dev-C++ window](image)

Most of the window area is currently occupied by a featureless gray area. When we create or add files to a project, a tabbed editor pane will appear here, one tab per file. (You can think of a "project" as being components necessary to be compiled and put together to create a program or library.) Note the white area to the left, which will enable us to browse through files within the project. Along the bottom is an area, currently empty, for logs and system messages. Along the top is a bank of convenient buttons. And way at the top is the main menu, including familiar options such as File, Edit, and Help, among others.
2. In Dev-C++, select **File -> New -> Project...**  This will pop up the **New project** window.

In the **New project** window, select the icon labeled **Console Application**. Type in **helloworld** for the **Name** in the lower left corner, and in the box in the lower right corner select **C++ Project**. Then click on the **Ok** button. This pops up a window titled **Create new project**.
4. In the **Create new project** window, browse into the **helloworld** folder you created in Step II above. After you've browsed to the proper folder, "helloworld" should be displayed in the "Save in" box at the top of the window, as seen in the preceding figure. Accept the default filename, **helloworld.dev**, and click on the **Save** button. This dismisses the **Create new project** window. A tabbed editor pane entitled [*] **main.cpp** now appears in the Dev-C++ window (see figure below); the [*] indicates that the pane's content has not been saved yet. This tabbed pane is an editor which allows you to edit code in C++.

5. Note that Dev-C++ has already inserted a skeletal C++ program in the [*] **main.cpp** tabbed pane, to get us started. This bare-bones program pops up a DOS command-line window with a prompt, but otherwise does nothing. We could compile and run this program right now, but instead let's edit it to make the program print out the traditional "Hello World!" message to the computer screen. Add the line

   ```
   cout << "Hello World!" << endl;
   ```

just after the opening curly bracket (those are double quotes around **Hello World!**), so that the program now looks like this:

```
#include <cstdlib>
#include <iostream>

using namespace std;

int main(int argc, char *argv[])
{
    cout << "Hello World!" << endl;
    system("PAUSE");
    return EXIT_SUCCESS;
}
```

The **<<** operator stuffs the character string "Hello World!" and an end-of-line (**endl**; that's a small "L" at the end, not a numeral "1") into a C++ object called **cout**, which causes "Hello World!" to be printed to the computer screen. Note that the command is terminated with a semi-colon.
6. Click on the **Save** button, which looks like an icon of a floppy disk 📁 (yes, I believe they are still in use). This pops up the **Save File** dialog box. Save the file with its default name `main.cpp` to the `helloworld` folder.

7. Then, select **Execute → Compile and Run**. Or equivalently, press the F9 key as a shortcut. A black DOS window should appear with the message “Hello World!”, followed by a message “Press any key to continue…”. (I'm not showing a picture of this window because it is otherwise rather boring. Also, it would be wasteful of ink if this tutorial were printed out.) This means that it worked! To dismiss this window, make sure that it is selected, by clicking on it if necessary, and then press any key on the keyboard. Dev-C++ requires you to dismiss this window before you can compile and run again. So, if you find that the **Compile and Run** option is unavailable, it could be that you forgot to dismiss the DOS window from an earlier run.

Since we're compiling a very simple program, it should compile and run without problem. But in practice, if there's some error in your code, the compiler will report errors in the log area at the bottom of the Dev-C++ window, pinpointing the exact lines in the file where errors are found. Correct the errors, and then try a **Compile and Run** again.
8. The **Compile and Run** step created a new *binary executable file* called `helloworld.exe` in the `helloworld` folder. In other words, it translated the human-readable *source code* in the file `main.cpp` and translated it into a binary file `helloworld.exe` that your PC knows how to run. You can re-run this program without recompiling it by pressing <Control-F10> within Dev-C++. You can also run it outside of Dev-C++ by bringing up a Windows folder browser, browsing to the `helloworld` folder, and then double-clicking on the file labeled `helloworld.exe`. Yet another way to invoke the program is to bring up a DOS command-line window, navigate to the `helloworld` folder in the DOS window, and then type `helloworld` at the DOS prompt, followed by a carriage return.

9. **Obtain Newmat (Source Code for Linear Algebra)**

   The point of this exercise is to provide tools for getting started in *scientific* programming. Thus far, we've gotten a taste of the "programming" part. We now need to address the "scientific" component. I have heard it said that the "natural language" of statistics is linear algebra. In this step, we'll obtain the source code for a C++ package that provides linear algebra classes, so that you can instantiate objects such as a Matrix or a ColumnVector and perform standard linear algebra operations on them, e.g. matrix multiplication. Here's how to obtain the Newmat source code:

   1. Go to Dr. Robert Davies’ download page, [http://www.robertnz.net/download.html](http://www.robertnz.net/download.html), and click on the link labeled "newmat11.zip". This will download the Newmat 11 source code in a single `.zip` file somewhere on your computer, possibly on your desktop.
   2. Double-click on the `.zip` file. You should see about 96 files, most with names ending in either `.cpp` or `.h`.
   3. Select all of the files and copy them into the `newmat` folder you created in Step II above.

4. **Create New C++ Project: Statically Linked Library**

   If you have a set of useful functions that will be used over and over again in different programs, it might be useful to collect them all into a *library*. Then you won't have to re-compile these functions over and over again each time you build new programs – you'll need to compile only the new programs, and then *link* them to the library to access the pre-compiled functions. In this step, I'll demonstrate how to build a library from the Newmat source code we downloaded in Step IV.1.

   Create a new Dev-C++ project by repeating Steps III(B) – III(C), but select the icon labeled *Static Library* rather than *Console Program*. Name the project `newmat`. Save the project into the `newmat` folder we created in step II; accept the default project name of `newmat.dev`.

   2. In Dev-C++, select Project → Add to Project. This pops up the Open File window.
   3. Browse to the `newmat` folder and select all the `.h` and `.cpp` files, EXCEPT `example.cpp`, `nl_ex.cpp`, `sl_ex.cpp`, `garch.cpp` and `test_exc.cpp`, and EXCEPT all files whose names begin with "tmt". Here's how to do this in an efficient way.

   1. **Select All Files.** Left-mouse-click on any of the files listed in the Open File window, so that it is highlighted in blue. Then type <Control-A> to select all the files. All of the filenames will now be highlighted in blue.
2. **Deselect certain files.** Press the Control key. While holding the Control key down, click on all files whose names begin with "tmt"; this de-selects them. Also while pressing down the Control key, click on the following files: nm_ex1.cpp, nm_ex2.cpp, example.cpp, nl_ex.cpp, sl_ex.cpp, garch.cpp and test_exc.cpp, to de-select them too. Leave all other files selected. (I know it's a little tedious; please bear with me here.) If you accidentally unselect a file that you shouldn't have, you can re-select it by clicking on it while still pressing the Control key. If you make a mistake and feel like you have to start all over, just return to step V(C1) above. When you're through, the result will look something like this:

![Open File dialog](image)

3. Click on the **Open** button. All of the selected files will then be added to the newmat project. The files should now be listed in the white pane along the left side of the Dev-C++ window. Note that the files in a project don’t have to be located in the same folder as the project; in this case, the files just happened to be kept in the same newmat folder as the project, just for convenience.
4. Press <Control-F9> to compile the static library. If all goes well, the message “creating newmat_lib.a” should appear in the log at the bottom of the Dev-C++ window, under Message. The Dev-C++ window should now look like this:

And that's all there is to it! This concludes part I of this tutorial.
5. **Suggestions for Further Exploration**

1. Learn more about Dev-C++’s functionality. Within Dev-C++, select Help → Help on Dev-C++ to bring up the online manual, and from there you’ll be able to learn more about this feature-rich programming environment. Next month, I’ll give you a brief glimpse of the debugger in Dev-C++.

2. Learn more about C++. There are many sources out there; I am sure that you can find many free tutorials, e-books, and even video courses online. The O’Reilly book I reference below may be a good place to start.

3. If you have no experience in programming in either C or C++, try the C programming course that comes packaged with Dev-C++. After selecting Help → Help on Dev-C++ in Dev-C++, look under the Contents tab for the item labeled An Introduction to C Programming, and then double-click on it. C++ is an extension of C, so anything you learn about programming in C will be very relevant to programming in C++.

4. Do some online research and try to determine the difference between a **statically** linked library and a **dynamically** linked library (DLL). What are the advantages and disadvantages of each sort of library?

That's all for this month. Next month, we'll make a small program that statically links the Newmat library we just created, and that demonstrates some of the possibilities with Newmat and with C++ in general. If you have any feedback on this column or ideas for future topics, please email me at jmm97@georgetown.edu. As always, your thoughts will be greatly appreciated.

Joe Maisog
Georgetown University / Medical Numerics

With thanks to Lanlan Yin for test-driving this tutorial; any errors of course remain my fault. **References.**


Dev-C++ website, [http://www.bloodshed.net/dev/devcpp.html](http://www.bloodshed.net/dev/devcpp.html)

Employment

As a service to local statisticians, *WSS News* provides notification of employment opportunities and description of those seeking employment here in the Washington, DC, area. Readers are encouraged to take advantage of this feature of the newsletter. The deadline for inserting notices is five (5) weeks before the publication date. Those interested should email or call Anne Peterson, at apeterson@insightpolicyresearch.com or (703) 373-6645.

**CLINICAL TRIAL BIOSTATISTICIANS**

M.S. and Ph.D. Level Positions

With an opportunity for substantial leadership responsibility in studies of international public health import.

The Biostatistics Center of The George Washington University, founded in 1972, is a leader in the statistical coordination of clinical trials conducted by the National Institutes of Health. We enjoy over $45 million per year of NIH research funding for major studies in cardiovascular disease, diabetes, maternal/fetal medicine, osteoporosis, urology, and the genetic basis for various diseases. The center has a staff of over 100 with 27 biostatisticians/epidemiologists, including 10 faculty. We are recruiting M.S. and Ph.D. level staff to participate in these and future studies. Please visit our web site (below).

Master's Level Research Positions: These positions require a Master's in Biostatistics or Statistics and 1-5 years experience in analysis, supervision of data management and study design for biomedical applications. Good written and oral communication skills, and detailed knowledge of SAS required. Send CV to address below.

Assistant to Full Research Professorial Positions are available immediately to serve as Co-Investigator or Principal Investigator (Project Director) and to provide statistical direction of the design, conduct and analysis of studies and the conduct of methodologic research to meet the projects needs. We are seeking individuals who want to join a highly competent team of academic biostatisticians and epidemiologists; who desire to contribute to the design and analysis of major medical studies, seek substantive scientific and statistical responsibility, enjoy interacting with medical investigators; take pride contributing to the publication of major papers in leading medical journals, and desire to make an impact on the public health. Our faculty also participate in graduate programs in biostatistics, epidemiology and statistics which afford opportunities for teaching at the graduate level. The research projects also provide an environment rich in methodological problems, with opportunities for collaboration with research active Center faculty and graduate students.

Minimum Position Requirements: Doctorate in Biostatistics, Statistics or Epidemiology, or alternatively an M.D. or Ph.D. in Biological Science, Physical Science or Computer Science with a Masters in Biostatistics or Statistics, 1-5 years' experience with clinical trials, especially study design and statistical analysis of study results using SAS, excellent oral and written English communication skills, and supervisory experience.

Application Procedures: Applicants must send a Curriculum Vitae and three letters of reference; a letter to include a synopsis of their role in collaborative medical research that has led to
medical scientific presentation or publication and a statement of career purpose indicating their career goals and how this position can help you achieve those goals; and applicants for Assistant Research Professor positions must send an Official Transcript of graduate coursework leading to the doctoral degree to: Sarah Fowler, Research Professor and Director, The George Washington University Biostatistics Center, 6110 Executive Blvd., Suite 750, Rockville, MD 20852.

HTTP://WWW.BSC.GWU.EDU

Review of applications is ongoing until the positions are filled. Rank/position title and salary commensurate with experience and qualifications. Tuition benefits for employees (including Ph.D. in Statistics, Biostatistics and Epidemiology) and for spouse and dependent children.

All research and regular faculty at the rank of Assistant Professor in Biostatistics or Statistics may apply for the Samuel W. Greenhouse Biostatistics Research Enhancement Award. For a period of 1 year, the award will provide 20% effort for methodological research and a discretionary fund to support professional activities, travel to professional meetings, supplies and equipment. Applicants for the research faculty position may also apply for the Greenhouse Award while their faculty application is being considered. For complete information including Award Application Materials Requirements, please visit our website at: www.bsc.gwu.edu.

The George Washington University is an Equal Opportunity/Affirmative Action employer

Survey Sampling Statistician

WESTAT: AN EMPLOYEE-OWNED RESEARCH CORPORATION

Westat is an employee-owned corporation headquartered in the suburbs of Washington, DC (Rockville, Maryland). We provide statistical consulting and survey research to the agencies of the U.S. Government and to a broad range of business and institutional clients. With a strong technical and managerial staff and a long record of quality research, Westat has become one of the leading survey research and statistical consulting organizations in the United States.

Our company was founded in 1961 by three statisticians. The current staff of more than 1,800 includes over 60 statisticians, as well as research, technical, and administrative staff. In addition, our professional staff is supported by data collection and processing personnel situated locally and in field sites around the country. The work atmosphere is open, progressive, and highly conducive to professional growth.

Our statistical efforts continue to expand in areas such as the environment, energy, health, education, and human resources. Westat statisticians are actively involved in teaching graduate-level courses in statistical methods and survey methodology in collaborative arrangements with area colleges and universities.

We are currently recruiting for the following statistical position:

Survey Sampling Statistician (Job Code WSS/DRM/7001)
Three or more years of relevant experience in sample design and selection, frames development, weighting, imputation, and variance estimation. Must have a master’s or doctoral degree in statistics and have excellent writing skills. Coursework in sample survey design is highly desirable.

Westat offers excellent growth opportunities and an outstanding benefits package including life and health insurance, an Employee Stock Ownership Plan (ESOP), a 401(k) plan, flexible spending accounts, professional development, and tuition assistance. For immediate consideration, please send your cover letter, indicating the Westat Job Code, and resume by one of the following methods to:

Job Code is REQUIRED to apply.
Westat • Attn: Resume System • 1650 Research Boulevard • Rockville, MD 20850-3195
Email: resume@westat.com • FAX: (888) 201-1452
Equal Opportunity Employer.   www.westat.com

Research Statistician

Requirements

Battelle is a world leader in science and technology research. Our Statistics and Information Analysis (SIA) group specializes in providing support to environmental, biomedical/health, transportation, engineering, and defense research projects. SIA is seeking a statistician for our Arlington, Virginia office for full-time, regular shift work. Occasional travel will be required to our Columbus, Ohio headquarters offices. Compensation will be based on qualifications and experience. A full benefits package will be provided. Relocation support is available.

Primary job responsibilities will include:

Help solve problems using statistics, computer, and people skills. Achieve high technical quality in assigned projects.
Organize and analyze data. Prepare charts, graphs, and tables to present data.
Assist with the preparation of written reports of results and contribute to sections of research reports and proposals.
Maintain both formal and informal communications and good relationships with internal clients.

This position offers potential for advancement based on demonstrated achievement.

Candidate resumes must demonstrate the following minimum requirements in order to be forwarded for consideration:

Master's degree or higher in statistics with expertise in statistical design and analysis techniques
Course work in regression, ANOVA, and experimental design
Experience with PCs and statistical software packages such as SAS, R, or S-PLUS
Ability to obtain security clearance is required.

Additional selection criteria will include the abilities to demonstrate outstanding initiative and be results oriented, communicate very well verbally and in writing, work effectively in multidisciplinary teams, and create clear goals under ambiguous conditions.

Desired qualifications include experience at providing support in statistical design and analysis to engineers or scientists. Coursework or research experience in chemistry, engineering, health, or other applied research fields is desired.

To apply for this position, go to the following page on Battelle's career website and follow the links:
https://recruit.battelle.org/ENG/candidates/default.cfm?szCategory=JobProfile&szOrderID=15191
Alternatively, you can reach the job by visiting www.battelle.org. From there click on "Careers", then click on Job Search and enter 15191 as the Requisition Number.

Research Analyst

Description

The Graduate Management Admission Council (GMAC) is a not-for-profit education organization of leading graduate business schools worldwide, dedicated to creating access to and disseminating information about graduate management education. The organization sponsors the Graduate Management Admission Test (GMAT), used as part of the admissions process by graduate management programs around the world.

The Research and Development department directly addresses the mission by systematically identifying issues, gathering information and supporting data, providing mission-critical syntheses, and conducting basic and applied research to better the quality and use of current and potential GMAC products and services.

This position supports the Council's commitment to disseminating actionable and relevant information about the management education community. The research analyst is responsible for managing and responding to GMAT data analysis requests, supporting the development of GMAT data products and publications, and managing the development and documentation of data files.

Primary Responsibilities

· Manage ad hoc GMAT data analysis requests
  o Screen and respond efficiently and thoroughly to internal and external data requests
  o Conduct descriptive and inferential statistical analyses using SPSS
  o Perform quality control procedures to maintain integrity of data
o Perform data management including, creating, merging, and archiving large data files
o Develop routine statistical programs
o Create and implement systems for tracking the progress of work and files
o Assure compliance with all company and department data privacy and security policies.

· Support the development of GMAT data products and publications.
  o Provide editorial and formatting assistance
  o Create tables and graphics
  o Conduct descriptive and inferential statistical analyses using SPSS

· Provide assistance inter-departmentally and intra-departmentally in integrating GMAC data and research and external research into reports and presentations.
· Develop, maintain, and document research data storage and retrieval systems
· Gather and organize secondary research on graduate management education industry
· Travel occasionally, as needed

Minimum Requirements

· Three years professional experience in a quantitative or research-focused field and a Bachelor's degree in a quantitative or research-focused field
· Minimum one year's experience using SPSS in a professional working environment
· Expertise in Microsoft Office Suite (Word, PowerPoint, and Excel)
· Strong quantitative/analytic abilities
· Strong project management skills

Desired Skills

· Master's degree in quantitative or research-focused field
· Accurate and highly detailed-oriented
· Excellent computer and technological skills
· Demonstrated ability to organize, plan, and multi-task
· Excellent oral, written, and interpersonal communication skills
· Adaptable to changes and demands
· Able to work effectively in a dynamic environment both independently and in a team setting.
· Ability to work under pressure, meet difficult deadlines, and set priorities
· High level of initiative
· Highly customer/client focused
GMAC values its highly talented employees and provides the ideal culture for innovative, motivated, and proactive individuals. We offer a superb work-environment, in addition to highly competitive compensation and a truly exceptional benefits package, featuring 100% employer paid health insurance, tuition reimbursement, a generous 403(b) retirement savings program, and much more.

We strongly prefer that all applications and r’sum, submissions be made through our online career center. https://erecruit.gmac.com. However, you may also e-mail/fax your resume to: careers@gmac.com/(703) 245-4340. Please visit our website: www.gmac.com.

The Graduate Management Admission Council provides equal employment opportunities to all employees and applicants for employment without regard to race, color, religion, gender, national origin, age, disability or other protected criteria, in accordance with applicable law.

Public Opinion Researcher

The Opportunity Agenda seeks a rigorous, entrepreneurial Public Opinion Researcher to manage the organization's public opinion research and media analysis; provide strategic input on research, communications and advocacy projects; and assist with program development and fundraising. The successful candidate will possess strong quantitative research, writing and oral presentation, and interpersonal skills.

Working under the direction of the Research Director and Communications Coordinator, the Public Opinion Researcher will manage the organization's public opinion research and media analysis. The ideal candidate should have at least five years experience performing related duties (education may supplement this experience). Experience working with--and/or having a commitment to--social justice campaigns a plus.

The Opportunity Agenda is a Washington/New York based social justice research/advocacy/communications group building a national dialogue to expand opportunity for all Americans. Details on the job and the Opportunity Agenda can be found at:

www.opportunityagenda.org/workforus

Applicants should send a letter of interest, CV/resume, and work sample to Tony Stephens, tstephens@opportunityagenda.org.

Note from the WSS NEWS Editor

Items for publication in the May issue of the WSS NEWS will be accepted until April 15, 2008. E-mail items to Michael Feil at michael.feil@usda.gov.
## Washington Statistical Society

**President**  
Michael P. Cohen  
202-232-4651

**Past President**  
Jill Montaquila  
301-517-4046

**President-Elect**  
Karel P. Krotki  
202-728-2485

**Secretary**  
Chris Moriarity  
301-458-4380

**Treasurer**  
Daniell Toth  
202-691-7380

**Representative-at-Large**  
Polly Phipps  
202-691-7513

Jami Schirm  
202-395-7314

Jeri Mulrow  
703-292-4784

**Vice Chair for District 2 of Council of Chapters**  
Glenn White  
202-327-6414

**Council of Chapters Representative**  
Jonaki Bose  
240-276-1257

**Student Representative**  
Joe Maisog  
703-465-2006

### Agriculture and Natural Resources
- Mel Kollander  
  703-642-8079
- Mike Fleming  
  202-366-5419
- Barry Nussbaum  
  202-566-1493

### Public Health and Biostatistics
- Grant Izmirlian  
  301-496-7519
- Myron Katzoff  
  301-458-4307

### Defense and National Security
- Wendy Martinez  
  703-696-4320
- Myron Katzoff  
  301-458-4307

### Short Courses
- Sylvia Dohrmann  
  301-610-5119

### Electronic Mail Committee
- Michael Greene  
  301-504-7335
- S.V. (Vince) Massimini  
  703-983-5893

### Webmaster
- Dan Jacobs  
  301-403-4220

### Employment
- Anne Peterson  
  703-979-1191

### Video Librarian
- Phil Kalina  
  703-725-6600

### Social Arrangements
- Yassmin Said  
  301-538-7478
- Yves Thibaudau  
  301-763-1706

### Video Coordinator
- John Dixon  
  202-691-7516

### Science Fair Coordinator
- Bob Clickner  
  301-294-2815

### WSS Program Chairs
- Agriculture and Natural Resources
  - Mel Kollander  
    703-642-8079
  - Mike Fleming  
    202-366-5419
  - Barry Nussbaum  
    202-566-1493

- Economics
  - Linda Atkinson  
    202-694-5046
  - Anne Polivka  
    202-691-7395

- Methodology
  - Meeva Khare  
    301-458-4312
  - Keith F. Rust  
    301-251-8278

- Public Health and Biostatistics
  - Grant Izmirlian  
    301-496-7519
  - Myron Katzoff  
    301-458-4307

- Public Policy
  - Michael L. Cohen  
    202-334-3765
  - Shelly Martinez  
    202-395-3147

- Quality Assurance and Physical Sciences
  - Amrut Champaneri  
    202-366-5998
  - Alan Jeeves  
    202-366-4194

- Defense and National Security
  - Wendy Martinez  
    703-696-4320
  - Myron Katzoff  
    301-458-4307

- Human Rights
  - Wendy Rotz  
    202-327-7822
  - Hormizd Kashi  
    301-594-7818

- Social and Demographic Statistics
  - Judy Droitcour  
    202-512-9145
  - Promot Chandok  
    202-360-2158

- Statistical Computing
  - Charlie Hallahan  
    202-694-5051
  - Dean H. Judson  
    301-763-2057

- Data Collection Methods
  - Sameena Salvari  
    202-484-4215
  - Nancy Clussen  
    202-484-5263
  - Carol Blumberg  
    202-586-6565
  - Eugene Burns  
    202-586-1385

- Membership
  - John Czajka  
    202-484-4685
  - John Dixon  
    202-691-7516
  - Timothy Kennel  
    301-763-6795
  - Adam Safir  
    202-974-8222
  - Fritz Scheuren  
    202-320-3446

- Video Coordinator
  - Fritz Scheuren  
    202-320-3446

- Historian
  - John Dixon  
    301-457-8322

- Science Fair Coordinator
  - Bob Clickner  
    301-294-2815